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Preface

Welcome to the Opsware Operational Management Database (OMDB), the first
configuration management database (CMDB) that offers seamless change automation.
Leveraging the Opsware System consisting of the Opsware Server Automation System
(SAS), Opsware Network Automation System (NAS), and the Opsware Application Storage
Automation System (ASAS), the OMDB automatically populates and maintains all the
infrastructure configuration items (Cls), their detailed attributes, and interdependencies.
After the OMDB is populated with the data, customers can easily execute changes to
configure and remediate the IT infrastructure.

Overview of this Guide

This guide describes how to use Opsware OMDB, starting with an introduction to the
system and how to navigate the user interface. It provides information about Search,
Reports, Dashboard, and Custom Reports.

Contents of this Guide

This guide contains the following chapters and appendices:

Chapter 1: OMDB Overview: Provides an overview of Opsware OMDB, the OMDB user
interface, the OMDB Client, and the Search feature.

Chapter 2: OMDB Reports: Provides an overview of the OMDB Reports feature, and how
to run, print, export and schedule reports.

Chapter 3: OMDB Dashboard: Provides an Overview of the OMDB Dashboard and how
to set the Dashboard options.

Chapter 4: Creating Custom Reports: Provides instructions for saving a search as a
report, using BIRT RCP Designer to design custom reports, and adding custom reports to
OMDB.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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Conventions in this Guide

This guide uses the following typographical and formatting conventions.

Bold Identifies field menu names, menu items, button names, and
inline terms that begin with a bullet.

Courier Identifies text that is entered or displayed at the
command-line prompt, such as Unix commands, Opsware
SAS commands, file names, paths, directories, environment
variable names, contents of text files that are viewed or edited
with a text editor, source code in a programming language,
and SQL (database) commands.

ltalics Identifies document titles, DVD titles, web site addresses.
Used to introduce new terms when they are first defined in a
document and for emphasis.

Icons in this Guide

This guide uses the following icons.

This icon represents a note. It identifies especially important
concepts that warrant added emphasis.

This icon represents a requirement. It identifies a task that
must be performed before an action under discussion can be

Iz performed.

This icon represents a tip. It identifies information that can
help simplify or clarify tasks.

W
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This icon represents a warning. It is used to identify significant
i information that must be read before proceeding.

Guides in the Documentation Set and Associated Users

The Opsware® SAS User's Guide: Server Automation is intended for system
administrators responsible for all aspects of managing servers in an operational
environment. It describes how to use Opsware SAS, introducing the system and the
user interface. It provides information about managing servers, remediating servers,
script execution, configuration tracking, deploying and rolling back code, and agent
deployment. It also explains how to use the Opsware Global Shell and open a Remote
Terminal on managed servers.

O,osware® SAS User’s Guide: Application Automation is intended for system
administrators responsible for performing the day-to-day functions of managing
servers. It reviews auditing and compliance, software packaging, visual application
management, application configuration, and software and operating system installation
on managed servers.

The Opsware® SAS Administration Guide is intended for administrators responsible for
monitoring and diagnosing the health of the Opsware SAS core components. It also
documents how to set up Opsware user groups and permissions.

The Opsware® SAS Planning and Installation Guide is intended for advanced system
administrators responsible for planning all facets of an Opsware SAS installation. It
documents all the main features of Opsware SAS, scopes out the planning tasks
necessary to successfully install Opsware SAS, explains how to run the Opsware
Installer, and details how to configure each of the components. It also includes
information on system sizing and checklists for installation.

The O,osware® SAS Policy Setter’s Guide is intended for system administrators
responsible for setting up OS provisioning, configuration tracking, code deployment,
and software management.

The Opsware® SAS Content Utilities Guide is intended for advanced system
administrators responsible for importing content such as software packages into

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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Opsware SAS. It documents the following command-line utilities: OCLI 1.0, IDK, and
DET (CBT).

* The Opsware® Automation Platform Developer’'s Guide is intended for software
developers responsible for customizing, extending, and integrating Opsware SAS. It
documents how to create Web Services, Java RMI, Python, and CLI clients that invoke
methods on the Opsware API.

Opsware, Inc. Contact Information

For more information, see the Opsware, Inc. main web site and phone number:
* http://www.opsware.com/index.htm
+ 41 (408) 744-7300

For links to the latest product documentation and software downloads, see the Opsware
Customer Support site:

* https://download.opsware.com/opsw/main.htm
For troubleshooting information, see the Opsware Knowledge Base:
* https://download.opsware.com/kb/kbindex.jspa

To contact Opsware Customer Support, see the following email address and phone
number:

* support@opsware.com

* +1(877) 677-9273

1 O Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 1: Introduction to the OMDB Client

This section discusses the following topics:
+ Overview of OMDB

« Launching the OMDB Client

+ OMDB Client

+ Key Terms and Concepts

+ Overview of Search

+ Overview of Quick Search

+ Overview of Advanced Search

* ltem Browser

Overview of OMDB

Opsware Operational Management Database (OMDB) is a configuration management
database designed to create and maintain a record of the infrastructure data in your IT
environment. It has the ability to store information from Opsware SAS, Opsware NAS, and
as well as other third party systems. You can use the OMDB Search, Reports, and
Dashboard features to view and analyze IT infrastructure such as applications, servers,
networks, and storage.

The OMDB feature enables you to perform the following tasks:

« Search and browse for configuration items in your IT environment.

+ Create reports and view report results on infrastructure data in your IT environment.
» Run existing reports and schedule reports.

« Aggregate report results to your dashboard.

Create custom reports.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 11
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Perform historical reporting and compare the results with the current report results.
Perform actions on search and report results.

Configure the data stored in third party systems with the OMDB data using the
Opsware Connector Development Kit.

Define security boundaries around the configuration items. You can thus constraint
OMDB feature access based on user permissions.

The OMDB Client provides the following features

Search: Enables you to search and browse for configuration items in your IT
Environment. See “Overview of Search” on page 16 for more information.

Reports: Enables you create reports, view report results, run existing reports, and
schedule reports. See “OMDB Reports” on page 31 for more information.

Dashboard: Enables you to aggregate report results to the dashboard. See “Overview
of Dashboard” on page 45 for more information.

Opsware Administration: Enables you to set the options for Scheduled Reports and
Dashboard. See “Setting Dashboard Options” on page 48 for more information.

Launching the OMDB Client
To launch the OMDB Client, perform the following steps:

E Launch the SAS Client. See the Opsware® SAS User’s Guide: Server Automation for

information on how to launch the SAS Client.

In the SAS Client, from the Tools menu, select Opsware OMDB Client. See

1 2 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 1: Introduction to the OMDB Client

Figure 1-1. This launches the OMDB Client.

Figure 1-1: Launching the OMDB Client

& Opsware Server Automation System
File Edit “iew W= Actions  Window  Help

Global Shell
Opsware OMDE Client wvare Policies

SEFver pdate Cache Chrl4+FS
Opkions

v W= AIF

|Saved Searches ... v| ﬂ - —
2| Independe

Advanced Search _g'_l LinL

E (Optional) To display Search in the Navigation pane, select Search Pane from the
View menu in the OMDB Client.

OMDB Client

The OMDB Client user interface provides an easy access to a OMDB features and
functionality. The OMDB Client user interface has the following main areas:

* Menus

» Navigation Pane

Content Pane

Status Bar

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 13
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Figure 1-2: OMDB Client
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Menus
The OMDB Client includes the following menus:

+ File: This enables you to open a new OMDB Client window, close the current
window, or exit all open OMDB Client windows.

« Edit: This enables you to cut, copy, paste, and delete text.

» View: This refreshes the current view and shows the latest information from the core
that you are currently logged into . You can also access OMDB features in the
Navigation pane, such as Reports (Reports, Dashboard, Scheduled Reports),
Advanced Search (Search, Quick Search), and Opsware Administration (Schedule
Report options, Dashboard options). This also allows you to show or hide the Search
pane.

« Actions: Depending on the feature that you have selected in the Navigation pane,
this menu enables you to perform OMDB functions.

« Window: This enables you to access multiple instances of OMDB Client windows, if
more than one window is open.

14 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 1: Introduction to the OMDB Client

* Help: This menu provides help for the OMDB Client. Help F1 provides context-
sensitive help relevant to the current feature window selected or opened (same as
F1). The contents and index will open the SAS Client help system to the main table of
contents.

Navigation Pane

To access OMDB features, select a feature in the Navigation pane. When you select a
feature, the details of it appears in the Content pane. You can access functions related to
it through the Actions menu.

Content Pane

Depending on the selection in the Navigation pane (Advanced Search, Quick Search,
Reports, Dashboard, Scheduled Report Options, Dashboard Options), the Content pane
lists the corresponding information.

Status Bar

At the bottom of the OMDB Client Application window, the status bar provides the
following information:

+ Informational text (left hand side) about the selected object
« A progress bar active when retrieving information from the core
* The user ID

» The time zone set in the user profile

Key Terms and Concepts

The following terms and concepts are used in the OMDB feature:

« Configuration Item (CIl): An object which can be viewed and managed with Opsware
OMDB. For example SAS Server, NAS Device, SAS Patch Policy.

+ Attribute: A single property of a configuration item, the value of which describes the
behavior of the configuration item. Configuration items can have one or more attributes.
For example, some of the attributes for the configuration item SAS Server includes
hostname, life cycle, agent status, and management IP.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 1 5
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Overview of Search

In the OMDB Client, the Search feature allows you search for any information about your
operational environment that is available in Opsware SAS, Opsware NAS, and any third
party systems. In the OMDB database using the Connector Development Kit, you can also
include additional configuration items and attributes from third party systems such as
storage management, change management, and ticketing. This allows you to search for
information about your IT infrastructure other than Opsware SAS and Opsware NAS. See
Opsware Connector Development Kit for information on how to add configuration items
and attributes from third party systems.

The OMDB Search feature enables you to perform the following actions:

+ Perform a search by using keywords.

« Perform an advanced search by creating search queries.

« Browse for configuration items in your IT environment.

+ Search for historical data by selecting the date and time for the search query.
+ Save a search query.

+ Perform actions on search results. You must have Opsware SAS 6.5 installed to perform
actions on SAS results and Opsware NAS 6.0 or later installed to perform actions on
NAS results.

» Export search results.
« Customize search results formatting using the Results Options window.

* View Item Browser for search results.

Performing a Search

In the OMDB Client, you can search for configuration items by entering a keyword in the
search text field. The search is carried out against the default displayable attributes
defined for the configuration item in the OMDB data catalog.

The search operation returns only configuration items on which you have the data access
permissions. See Opsware® OMDB 1.0.1 Installation Guide for information on OMDB
permissions.

To carry out a search, perform the following steps:

1 6 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 1: Introduction to the OMDB Client

From the Navigation pane, select Search. To display Search in the Navigation pane,
select Search Pane from the View menu.

From the drop-down list, select the type of item that is the target of the search.
Figure 1-3 shows a search for the NAS User named Bob.

Figure 1-3: Simple Search in the OMDB Client

N.&.S I=zer Vl
| Bab =
El Enter the search text in the text field. The OMDB Client search feature does not

support a wildcard search and the search is not case sensitive.
Click to search. The search results appear in the Content pane.

(Optional) Click on any column heading to sort the search results. You can also
change the order of the columns by dragging the column heading and dropping it
into the desired location.

(Optional) Click Results Options to specify the attribute to be displayed as column
headings for the search results. Perform the following steps to customize the column
headings:

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 17
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1. In the Results Options window, from the All Available Attribute list, select the
attributes you want to display as column headings for the search results. Click
Add. The attributes now appear on the right pane. See Figure 1-4.

Figure 1-4: Results Option Window

Result Options...

Corfiguretion tem: | SAS Server v | Airibute Display Name Sorting
All Available Attributes Server Name 1 Azcending
Agset Tag A Frirnary IP
Hosthame Operating System 2 Ascending
Lifecycle Key
anufacturer
Management IP |
Hetes Macel
Aokl |
COpsware Server D Liferyele
Origgin _
Origin Key L
Reported 05
Serial humber
Stage
Stage Hey

Use
Usze Key
Agent
Agent Checkin
Agent Discovery Date
Agent Status Key
Agent Version

Column Detail

Configuration ferm: SAS_SERWER J
Attribute: ‘ ;E*ﬂié‘tia{us

Column Display Mame: ! Status of Oy

Sorting Order: ﬁé_sa-e-d =

[ OK ] [ Cancel I [ Apply ] l Help

2. To reorder the attributes, select the attribute and then click Up or Down. To
remove the attribute, select the attribute and then click Remove.

3. To change the display name of the attribute in the column heading, enter a new
name in the Column Display Name field.

4. To select the sort order of the attribute on the search results, select the order
number from the Sorting Order drop-down list.

5. To sort the search results for a each attribute, select Ascending or Descending
from the Sorting Order drop-down list.

6. To make the sorting order case sensitive, select the Case Sensitive check box.

7. Click OK to display the selected attributes as column headings. Click Apply to
save.

1 8 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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8. To add additional attributes, select the relationship from the Configuration Item
drop-down list as shown in Figure 1-5. The additional attributes appear in the All
Available Attribute list. Perform the instructions listed in step 1-7 to add or remove
additional attributes.

Figure 1-5: Adding Additional Attributes to the Results Option Window

Result Options... @
Configuration flem: SAS Server ¥ Aftribute Display Mame Sorting |
All Available Attributes Server Name 1 Aszcending
Eanara ~ MAlocaled To SAS Customer |
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1A udited By SAS Andit Manutacturer

Connects To NAS Device Maodel

Agent

Calumn Detail
Configuration tem:
Adfribute: L
Caluran Display MName: i

Sorting Order:

\Has Instalied SA5 Operating System Litecycle
Located fn SAS Facifity |

\Member OF SAS Server Graup SINOVE {Status of Opsware Agert
|Pracessed By SAS Job [RusomonStats

2
Reported O
Serial Mumber
Stage

Stace Key
Use

Use Key

Agent Checkin
Agert Discovery Date
Agent Status Key |

Ok I [ Cancel ] l Lpply ] [ Help

(Optional) Click Save to save your search query. The Save Search window appears.
Enter the name of the search and click Save. The name of the saved search cannot
be more than 64 characters. The search is saved in a folder corresponding to the
configuration item types in the Advanced Search location in the navigation pane.

(Optional) In the Save Search window, select Save Search as Report Definition to
create custom reports. See “Creating Custom Reports” on page 53 for more
information.

(Optional) Click Export at the bottom of the screen to export search results. The
Export Results window appears. Enter the location, the file name and the file type
and then click Export Results. You can export OMDB search results as .csv or .html
files.

KK (Optional) After you export the search results, you can email the search results by

attaching the exported file to the email. You can also print the search results by
printing the exported file from an application that supports .csv or .html files.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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EEl (Optional) To perform an action on the search results, select an item from the
Content pane and then from the Actions menu, select the appropriate action.

Overview of Quick Search

Quick Search allows you to browse all the configuration items available in OMDB by
selecting the configuration item and then the attribute and value for that item.

Performing a Quick Search

The search operation returns only configuration items on which you have the data access
permissions. See Opsware® OMDB 1.0.1 Installation Guide for information on OMDB
permissions.

To carry out a quick search, perform the following steps:

H From the Navigation pane, select Advanced Search » Quick Search. Quick
Search is displayed in the Content pane as shown in Figure 1-6.

Figure 1-6: Quick Search in the OMDB Client

File Edit ‘iew Actions ‘Window Help
Search | ¥ Quick Search
lSAS Tkl s | fterm Type ; Attribute Category Attribute Yalue
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Advanced Search Compliance ast Agent Report
= i A5 Server Group s Custom Attributes N
® 2 advanced Search o | (# |< | i |
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Server Mame | Serial Mumber | Primary [P Operating Sy... Manufacturer | Model Hosthame e
8-” mass nedey... WWWARE-SE . 101258585 Red Hat Erter.. WMWARE, INC. WIMWARE VIR... m3SSncdey....
ﬁ{l omdb.nci 0., YMYWARE-SE .. 101281168  Red Hat Erter... WYMAARE, INC. WMWARE YIR... omdbnci Q...
8—” zas.ncllncd... WhWARE-3G .. 1012511 66  Red Hat Erter... WWMWARE, INC. WMAWARE YIR... sas.nc10ncd..
-
Opsware Administration [ Save Search... ] [ Export...
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Chapter 1: Introduction to the OMDB Client

From the Item Type list in the Content pane, select the configuration item you would
like to browse. The list of attribute category for the selected configuration item appear
in the Attribute Category list.

Select the attribute from the Attribute list and then select the value for that attribute
from the Value list. The search results appear in the content pane.

(Optional) Click on any column heading to sort the search results. You can also
change the order of the columns by dragging the column heading and dropping it
into the desired location.

(Optional) Click Save to save your search query. The Save Search window appears.
Enter the name of the search and click Save. The name of the saved search cannot
be more than 64 characters. The search is saved in a folder corresponding to the
configuration item type in the Advanced Search location in the navigation pane.

(Optional) In the Save Search window, select Save Search as Report Definition to
create custom reports from your search results. See creating custom reports for more
information.

(Optional) Click Export at the bottom of the screen to export search results. The
Export Results window appears. Enter the location, the file name and the file type
and then click Export Results. You can export OMDB search results as csv or .html
files.

(Optional) After you export the search results, you can email the search results by
attaching the exported file to the email. You can also print the search results by
printing the exported file from an application that supports .csv or .html files.

(Optional) To perform an action on the search results, select an item from the
Content pane and then from the Actions menu, select the appropriate action.

Overview of Advanced Search

In the OMDB Client, an Advanced Search enables you to create queries on search items.
In the search query, you can specify rules and combine each rule with a logical “And” or
“Or” operator. You can use both the “And” and “Or” operator in a single search query.
Each rule is a combination of an attribute/operator/value that enables you to search for a
specific attribute value for the selected search item. For the search item, depending on
the attribute that you select, the options for the operator and value are displayed. You can

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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specify the attribute values by entering text or a numerical value in the text field, or by
selecting a value from the drop-down list, or by selecting multiple values from a list of
values in the Select Values window. See Figure 1-7.

Figure 1-7: Advanced Search

ﬁ Advanced Search

Search far Configuration term: EAS Server v | Az of Date: | Thy 0372972007 B Time: 9:.00 Ph hat
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|and v| | Agent Status v| kquals v| |OI~(
[ Search ] [ Rezult Options... ] [ Save Search... ] Cancel

The Select Values window appears when you need to specify multiple values for a rule
containing a “is one of” or “is not one of” operator. In this window, you can select multiple
values from the list or add values to the Additional field. See Figure 1-8.

In OMDB when you perform a search of any configuration item and the in the operator
field you select " Equals” or “Does not equal" or “Is one of” or “Is not one of”, then the
values listed in the Value field depends on the values existing in the OMDB atabase as of
the selected date. If the other values in the OMDB database are not relevant for the
selected date then those values will not be listed in the Value field.

22 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Figure 1-8: Select Va
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You can create complex queries by selecting multiple relationships or In-Line blocks for a

configuration item and also multiple rules for each relationship. See Figure 1-10.

Figure 1-9: Complex Query Containing Multiple Relationships
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In a complex query, you can also set the precedence on the Or/And logic for the different
rules in that query. In any query, by default the Or logic takes precedence over the And
logic. In Advanced search, you can use the In-Line Search Block to prioritize the And/Or
logic for rules in a query. See Figure 1-10.

Figure 1-10: Complex Query Containing In-Line Block

@ Advanced Search
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Using Advanced Search you can search for historical data by selecting the date and time
for the search query. You can then compare the historical data with the current results or
create custom reports for both the current search results and the historical search results.
See “Creating Custom Reports” on page 53 for information on how to create custom
reports.

Performing an Advanced Search
The search operation returns only configuration items on which you have the data access

AS
permissions. See Opsware® OMDB 1.0.1 Installation Guide for information on OMDB
permissions.

To carry out an advanced search, perform the following steps:

E From the Navigation pane, select Advanced Search » Advanced Search. The
Advanced Search page appears in the Content pane.
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H From the Search for Configuration Item drop-down list, select the item you want to
search. From the As of Date drop-down list select the date and from the Time drop-
down list select the time to carry out the search.

Figure 1-11: Advanced Search in the OMDB Client

1@ aAdvanced Search

Search for Configuration kem: Mz of Date: E] Time:
Mstching the following criteris:
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[ Search ] [ Result Options.. ] [ Save Search...

Create a rule by selecting the attribute from the first drop-down list. Depending on
the attribute that you select, options available for the operator and values for the rule
could change.

Bl Select the operator from the second drop-down list. The operator selected defines
how the search text is treated.

H Enter a value in the field or select a value from the drop-down list or click [ to
select multiple values from the Select Values window.

A Click to add additional rules and repeat steps 3 to 5. Click E] to delete any
rules.

Select the logic (And/Or) to be applied for every rule in the query.

B (Optional) To add relationships to the search query, select the relationship ( indicated
in italics) from the first drop-down list. Create rules by following instructions listed in
step 3 -7.

El (Optional) To set precedence for any rules in a query, select In-Line Search Block
from the first drop-down list. Then create rules for the query by following instructions
listed in step 3 -7.

KK Click Search to run the search query. The search results appear in the Content pane.

EEl (Optional) Click on any column heading to sort the search results. You can also
change the order of the columns by dragging the column heading and dropping it
into the desired location.
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EHE (Optional) Click Results Options to specify the attribute to be displayed as column
headings for the search results. Perform the following steps to customize the column
headings:

1.

In the Results Options window, from the All Available Attributes list, select the
attributes you want to display as column headings for the search results. Click
Add. The attributes now appear on the right pane.

To reorder an attribute, select the attribute and then click Up or Down. To remove
an attribute, select the attribute and then click Remove.

To change the display name of the attribute in the column heading, enter a new
name in the Column Display Name field.

To select the display order of the attribute on the search results, select the order
number from the Sorting Order drop-down list.

To order the search results for a each attribute, select Ascending or Descending
from the Sorting Order drop-down list.

To make the sorting order case sensitive, select the Case Sensitive check box.

Click Apply to display the selected attributes as column headings. Click OK to
close the window.

To add additional attributes, select the relationship from the Configuration Item
drop-down list as shown in Figure 1-5. The additional attributes appear in the All
Available Attribute list. Perform instructions listed in step 1-7 to add or remove
attributes.

EEl (Optional) Click Save to save your search query. The Save Search window appears.
Enter the name of the search and click Save. The name of the saved search cannot
be more than 64 characters. The search is saved in a folder corresponding to the

configuration type in the Advanced Search location in the navigation pane.

EEd (Optional) In the Save Search window, select Save Search as Report Definition to

create custom reports. See creating custom reports for more information.

EHE (Optional) Click Export at the bottom of the screen to export search results. The

Export Results window appears. Enter the location, the file name and the file type
and then click Export Results. You can export OMDB search results as .csv or .html

files.
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Ed (Optional) After you export the search results, you can email the search results by
attaching the exported file to the email. You can also print the search results by
printing the exported file from an application that supports .csv or .html files.

(Optional) To perform an action on the search results, select an item from the
Content pane and then from the Actions menu, select the appropriate action.

Exporting Search Results

To export search results, perform the following steps:

E Perform a search in the OMDB Client. The search results appear in the Content pane.

H Click Export at the bottom of the screen to export search results. The Export Results
window appears.

Enter the location, the file name and the file type and then click Export Results. You
can export OMDB search results as .csv or .html files

Running a Saved Search Query

To run a saved search query, perform the following steps:

E From the Navigation pane, select Advanced Search » Advanced Search.

H Navigate the folder hierarchy to select the search query. The search results will
appear in the Content pane.

Deleting a Saved Search

To delete a saved search query, perform the following steps:

E Fom the Navigation pane, select Advanced Search » Advanced Search.

H Navigate the folder hierarchy to select the search query. The search results will
appear in the Content pane.
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Click Save. The Saved Search window appears as shown in figure Figure 1-12.

Figure 1-12: Delete Search
Save or Delete your search b—<|

Search Name
| Search for MAS Device |

Saved Searches

|:| Save as a Report Definition

[ Save ] [ Delete ] [ Cancel

Bl Select the saved search and click Delete. Click Delete on the Confirmation window
to delete a saved search.

Item Browser

The Item Browser in the OMDB Client allows you to view all the available attributes for the
selected configuration item. The Item Browser enables you to view additional information
about the configuration item and its relationships.
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The Iltem Browser consists of two main components: the Views pane and the Content
pane. The Views pane lists all the available attribute categories for the selected
configuration item, and the Content pane displays the details of the selected attribute.
When you select an attribute in the Views pane, its corresponding details appears in the
Content pane. See Figure 1-13.

Figure 1-13: Item Browser
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The list of attribute categories in the Item Browser varies depending on the configuration
item returned in the search or report results. For example, Figure 1-13 is an ltem Browser
for the configuration item SAS server, and Figure 1-14 is an Item Browser for the
configuration item NAS device switch.

Figure 1-14: Item Browser for NAS Switch
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Accessing the Iltem Browser
Perform the following steps to access the Item Browser:
E nthe OMDB Client, perform a search or run a report.

H Select an item from the search or report results and then from the Actions menu,
select View. The ltem Browser for the selected configuration item appears.
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This section discusses the following topics:
+ Overview of OMDB Reports

+ Reports Features

+ Opsware OMDB Client Reports
+ User Permissions

+ Launching the Reports Feature
+ Reports Display

* Running a Report

+ Report Results

» Exporting a Report

+ Printing a Report

« Scheduling a Report

Overview of OMDB Reports

The Opsware OMDB Client Reports feature provides comprehensive information about
managed servers, network devices, software, patches, customers, facilities, operating
systems, compliance policies, and users and security in your environment. These
parameterized reports are presented in graphical and tabular format, and are actionable—
which means that you can perform appropriate actions on objects, such as a policy or an
audit, within the report. These reports are also exportable to your local file system (as .pdf,
.html and xls files) to facilitate use within your organization.

This section contains information about the types of OMDB Client reports, how to modify
report parameters, how to run the reports, and how to perform actions in the report
results.
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Reports Features

OMDB Client Reports enable you to perform enterprise health assessments by providing
the following features:

Actionable reports that enable you to take the appropriate action on objects within the
reports. For example, in the list view of a compliance report, you can select a server
and open a Remote Terminal or Server Explorer to browse it, perform an audit, create a
snapshot, create a package, and so on.

The OMDB Client Dashboard provides a display of selected reports. See “OMDB
Dashboard” on page 45.

Reports that are data-secured—controlled by the user’s permissions to the data.
Reports that can be run on either current or historical data.

Reports that are printable and also exportable to .pdf, .html, and xIs formats. You can
export reports to your local file system for use within your organization.

Custom reports can be created and imported. See “Creating Custom Reports” on page
58.

Reports that can be scheduled to run automatically and to email the results to you and
others.
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Opsware OMDB Client Reports
Table 2-1 lists the OMDB Client Reports by report folders.

Table 2-1: OMDB Client Reports

Compliance History Historical Compliance Summary - Groups the compliance his-
tory of measured servers

Historical Compliance Detail - Provides device compliance
detail for a specified customer, facility, or group

Device Compliance History - Provides a detailed compliance
state history for all servers, or for one or more selected servers

Device Group Compliance History - Summarizes the compli-
ance history of devices in a specified device group

Customer Compliance History - Summarizes the compliance
history of devices assigned to a specified customer

Facility Compliance History - Summarizes the compliance his-
tory of devices in a specified facility

Deployment Life Cycle | Devices By Type - Filters network devices by group, and non-
network devices by customer, facility, or group

Network Devices By Device Type - Provides a deployment
trend history for the network devices in a specified group,
organized by device type

Servers By Operating System - Provides a deployment trend
history for the servers in a specified customer, facility or group,
organized by operating system and version

Servers By Architecture - Groups the servers in a specified
customer, facility or group organized by architecture
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User Permissions

Reports are controlled by the user’'s permissions to access the data. If a user does not
have permissions to view a set of servers, those servers will not display in a report run by
that user.

Launching the Reports Feature

To launch the Reports feature, perform one of the following steps:
« From the Navigation pane, select Reports.

* From the View menu, select Reports » Dashboard.

* From the View menu, select Reports > Reports.

« From the Navigation pane, select Scheduled Reports.
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Reports Display

The Reports feature display consists of a Search pane, a Dashboard, Scheduled Reports,
report folders, and report parameters.

Figure 2-1: The Reports Feature Display

& Opsware OMDB Client
File Edit View Window  Help

B ropors

SAS Server v|

Reports
| | Thiz folder containg reports for Opsware OMDE.

= [9' Compliance History
Historical Compliance Summary
Historical Compliance Detail
Device Compliance Histary
Device Group Compliance History
Customer Compliance History
Facility Compliance Histary

= [? Deploymernt Life Cycle
Devices By Type
Metwork Devices By Device Type
Servers By Operating System
Servers By Architecture

Dashboats

@ Scheduled Reports

Advanced Search

Opsware Administration

1 item [ ]| surnett | ved May 09 17:34 2007 EtcaucT

Search Pane

In the Reports feature, you can use the OMDB Client Search feature to find reports by
defining specific filter criteria. You can save a search as a report definition and create
custom reports.

Dashboard

The Dashboard provides a display of selected reports. See “Overview of Dashboard” on
page 45 for more information.
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Report Folders
Reports are organized in the following folders according to regulatory or IT best practice

standards:

« Compliance History: This folder contains reports about compliance for software
policies, audit policies, and patch policies by servers, customer, and facility.

- Deployment Life Cycle: This folder contains reports about attributes of servers and
network devices.

« Custom Reports: This folder contains any custom reports you have created. For more
information on creating custom reports, see ““Creating Custom Reports for OMDB” on
page 55.
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« Figure 2-2 illustrates the Report folders in the Navigation pane, including the reports
you will find in each folder.

Figure 2-2: Report Folders
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Report Parameters

Many reports require input parameters in order to be run. For reports that require
parameters, you can run the report with its default parameter values or modify the
parameter values. If you want to run a report that includes or excludes certain servers,
customers, or hardware models, you need to specify this criteria in the report parameters.
See “Running a Report” on page 38.
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Running a Report

To run a report, perform the following steps:

From the Navigation pane, select Reports.

Expand the Reports folder and then expand Compliance History.
Select one of the reports listed in the folder.

If there are no report parameters in the Content pane, click Run.

If there are report parameters in the Content pane, you can either use the default
parameters or change them:

» To use the default report parameters, click Run to run the report.

» To change the report parameters, see “Modifying Report Parameters” on page 38.

Modifying Report Parameters

You can modify the default parameters of a report. If you modify the parameters of a
report, your changes become your default settings for that report. To modify the default
parameters and run a report that includes certain servers, customers, hardware models,
and so on, perform the following steps:

(Optional) Select the date and interval.

In the drop-down list for (the Server, Customer, Model, and so on), select Contains,
Equals, Begins With, or Ends With.

(Optional) Select the ellipsis (...) button to the right of the [Any Valuge] fields to open
the Select Values window.

In the Select Values window, select a value in the Available or Selected pane and
then use the directional buttons to include it in or exclude it from your search criteria.

Click OK to save your changes.

Click Run to run the report.

If data cannot be found to run the report, a “No records to display!” error displays.
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Report Results

Report results initially appear in a graphical or list view. The graphical report is an
overview of available data for this report displayed in a pie chart or in a bar graph.

Graphical Report

A graphical report is a bar graph or a pie chart. See Figure 2-3 for an example.

Figure 2-3: Bar Graph
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List Report

A list report is a tabular display of information. Double-click on a row in the list, such as a
server, audit, or policy, for more detail or to perform an action. See Figure 2-4 for an
example.

Figure 2-4: List Report
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Exporting a Report

You can export a report for use in other applications in your environment and attach a
report for email distribution. Depending on the report format, you can export a report to
your local file system as a .pdf file, an .html file, or an xls file.

To export a report, perform the following steps:
E From the report, click Export to open the Save window.

H nthe Save in field, enter a location that identifies where you want to save the file to,
or select from the drop-down list.
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B Select the file type, such as .html or xls.
Bl Enter afile name.

B Click Save.

Printing a Report

To print a report, perform the following steps:
E From the report, click Print to open the Print window.

H Use the default print options or modify them, and then click OK.

Scheduling a Report

You can schedule a report to run at a specified time, and to repeat at intervals. The report
can be emailed to one or more recipients when it runs.

To schedule a report, perform the following steps:

H From the report, click Schedule to open the Scheduled Report Options window
shown in Figure 2-5.

In the Schedule Name field, enter the name. The default value is the report type
name.

Select the frequency, either Once, Daily, Weekly, or Monthly.
(Optional) Select the options available for Daily, Weekly, and Monthly, as appropriate.
Set the Start Time.

Set the Start Date.

[~ o I o I~ I

(Optional) Select End recurring schedule by, and then set the end date.

In the Recipients field, enter one or more email addresses. If you are entering,
multiple addresses, the addresses can be separated by a space, comma, semicolon,
or a Return.

El Select a format for the report output.
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KK Click OK.

Figure 2-5: Scheduled Report Options

€’ Scheduled Report Options

Description

Schedule Natne: | Historical Compliance Detai |

EBazed on Report: Historical Compliance Detail

Schedule

Enahble the following schedule:

{:} Once Run every day(=) at the specified start time.
(%) Daily
{} Weekly

() Manthly

Start Time:

=tart Date: |Wed 05/09/2007 |[ﬂ [ ] End recurring schedule by: v

Recipients

E-tnail: A

Format: @ poF  (COus O HIML

Ok ] [ Cancel

Setting Scheduled Report Options

For scheduled reports an Administrator can set the following options:
+ Maximum number of scheduled reports each user can enable

* Number of scheduled reports concurrently processed by server

The ‘Maximum number of scheduled reports each user can enable” option allows an user
only to enable the number of reports as set by the administrator. This option does not
prevent the user from creating unlimited number of scheduled reports.
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If the administrator lowers the number of scheduled reports that a user can have enabled,
then the next time the user updates or creates a scheduled report, they may have to also
disable a number of their reports until they no longer exceed the maximum number of
scheduled reports. This option also will not allow the user to save changes to a scheduled
report if they have already enabled the maximum number of scheduled reports.

The “Number of scheduled reports concurrently processed by server” option enables an
Administrator to monitor that the server that processes scheduled reports are running
smoothly. This setting is designed to keep the server from crashing due to an excessive
number of reports being scheduled at the same time.

In the event that there are more scheduled reports scheduled to run at a specific time
than specified in this value, then the server will process the scheduled reports in batches
of the size specified in this value. Therefore, sometimes reports may not run at the time as
specified by the user. Running some reports may be delayed due to server load.

To set the options for scheduled reports, perform the following steps:

E nthe OMDB Client, from the Navigation pane, select Opsware Administration »
Scheduled Report Options. The Scheduled Report Options options appears in the
Content pane.

H Enter the value for the Maximum number of scheduled reports each user can enable
option.

E Enter the value for the Number of scheduled reports concurrently processed by
server.

Bl Click Save to save the Scheduled Report options.
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This section discusses the following topics:
+ Overview of Dashboard
+ Viewing the OMDB Dashboard

+ Setting Dashboard Options

Overview of Dashboard

The OMDB Dashboard displays useful summary type OMDB reports allowing you to view
important reports on a daily basis. It contains one or more of the following summary
reports in a graphical format:

+ Historical Compliance Summary
» Devices by Type

+ Servers by Architecture

» Network Devices by Type

+ Servers by Operating System

You can drill down to the summary report to view the complete report in detail. In the
Dashboard, you can perform the following actions on the summary reports:

* Print reports

+ Export OMDB report results as xIs, .ntml, or .pdf files

+ Drill down the summary report to view the complete report in detalil
» Perform action on report results

By default, the Dashboard contains the following five summary reports as shown in
Figure 3-1:
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Compliance % Over the Last 30 Days: This report displays the compliance history of
servers and network devices over the last 30 days at daily intervals.

Devices by Type Over the Last 30 Days: This report displays the devices (servers and
network devices) deployed over the last 30 days at daily intervals.

Servers by Operating System Over the Last 30 Days: This report displays the
servers organized by operating system and version over the last 30 days at daily
intervals.

Network Devices by Type Over the Last 30 Days: This report displays the network
devices (such as routers, switches) deployed over the last 30 days at daily intervals.

Servers by Architecture Over the Last 30 days: This report displays the servers
organized by CPU architecture over the last 30 days at daily intervals.
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Figure 3-1: OMDB Dashboard
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In the OMDB Client, you can also create and configure your own personal Dashboard. You
can select up to eight reports to be displayed in your personal Dashboard from the list of
reports mentioned above. You can also configure your personal Dashboard to be in either
a one-column or two-column layout. See “Setting Dashboard Options” on page 48 for
more information.

When you launch the OMDB Client, by default the Search feature is displayed in the
Content pane. You can also configure the dashboard options to display the Dashboard
feature in the Content pane when you first launch the OMDB Client. See “Setting
Dashboard Options” on page 48 for more information.

Viewing the OMDB Dashboard

To view the Dashboard in OMDB, perform the following steps:

E nthe OMDB Client, from the Navigation pane, select Reports » Dashboard. The
default Dashboard appears in the Content pane.

H To create your personal Dashboard, see “Setting Dashboard Options” on page 48.

(Optional) To view the complete report in detalil, click on any report in the Dashboard.
The complete report appears in the Content pane.

Bl (Optional) Click Export to export the reports displayed in the Dashboard. The Export
Results window appears. Enter the location, the file name and the file type and then
click Save. You can export OMDB report results as .xIs, .html, or .pdf files.

(Optional) Click Print to print the reports displayed in the Dashboard.

B (Optional) To perform an action on the report results, select an item from the Content
pane and then right-click to select the appropriate action.

Setting Dashboard Options

In the OMDB Client, you can create and configure your own personal Dashboard. You can
select up to eight reports to be displayed in your personal Dashboard and specify the
parameter values for those reports. You can also configure your personal Dashboard to be
in either a one-column or two-column layout.

To configure the Dashboard options, perform the following steps:
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E nthe OMDB Client, from the Navigation pane, select Opsware Administration »
Dashboard Options. The Dashboard options appears in the Content pane.

Figure 3-2: Dashboard Options Window

% Dashboard Options
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D Reports @ Use Default Dashboard Q} One Column
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Report File |Servers By Architecture w |

Title | |
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=
o
=1
=

Report File |Netwc-rk Devices By Device Type % |

Title | |

Report: 5

Save Layout

H From the Startup Location list, select an option. This option allows you to select the
OMDB Search, Report, or Dashboard feature to be displayed every time you launch
the OMDB Client. Selecting the Dashboard option allows you to display the
Dashboard feature when you launch the OMDB Client.

B From the Dashboard Selector list, select Custom Dashboard to configure your
Dashboard using the reports that are available.
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Bl From the Custom Dashboard Column Selector list, select One Column to display the
reports in a one-column format in the Dashboard. Select Two Columns to display the
reports in a two-column format in the Dashboard.

H To configure a report in the Dashboard, perform the following steps:

Different reports have different report parameters to configure. For example, for the report

"Network Devices by Device Type," you can configure the parameters such as Device
Group, Vendor, and Model. For the report “Servers by Operation System”, you can
configure the parameters such as Customer, Facility, and Device Group.

1. From the Custom Dashboard Configuration Panel in Report 1, select a report from
the Report File drop-down list.

2. (Optional) Enter the report title in the Title field or else the default report name will
be used.
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3. Click Configure. The Report Dialog window appears.

Figure 3-3: Report Dialog Window
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4. From the Date Range drop-down list, select a date range to run the report.

5. From the Interval drop-down list, select the time interval to run the report. The
Interval drop-down list allows you to group the data on a daily, weekly, or monthly
time interval.

6. From the Customer drop-down list, specify the customer to be included or
excluded in the report.

7. From the Facility drop-down list, specify the facility to be included or excluded in

the report.
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8. From the Device Group drop-down list, specify the device group to be included or
excluded in the report.

9. Click Run. The report with the specified parameters is displayed in the Content
pane.

10. Click OK to save your changes or click Cancel to close the window.
@ To configure more reports, repeat the steps listed in Step 5.

Click Save Layout to save the Dashboard options.
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This section discusses the following information:
+ Introduction

+ Creating Custom Reports for OMDB

Introduction

Opsware SAS enables you to create and design reports and integrate them into the SAS
Client and the Opsware Operational Management Database (OMDB) Client.

The Opsware family of products is comprised of a cluster of Oracle databases, typically
running on a Sun Microsystems minicomputer. These databases are continuously
refreshed and updated by agents residing on the managed servers and workstations in
the network.

This chapter presents how to use content selected from these databases and create
custom reports. It explains how to create a simple SQL query, how to design a report, and
how to integrate it into the Opsware OMDB user interface.

Report Design

Begin your report design by defining its content. You should determine the report’s
purpose, the type of information displayed, and the logical grouping of the data set. After
you have defined the content, you map the content definition into the product-specific
database schema by determining how Opsware should represent the data needed, the
names of the tables where the data is stored, and the names of all of the fields within
those tables.

Using this information you can write the SQL query that Opsware will use to generate the
report.
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Writing the correct SQL query is the most difficult part of report creation. The standard
reports contain a set of queries that are good candidates to borrow work from. The report
(.rptdesign) files can be found in an installed core at /opt /opsware/omdb/reports.
Whether borrowing from existing reports or creating original content, use a good tool like
PL/SQL Developer to refine and optimize your SQL.

When you have optimized the SQL, you should test your SQL query to ensure that the
SQL is valid and returns the expected data.

No AAA-specific considerations need to be made in your SQL. The report engine will

AS
automatically transform the SQL that you have created at runtime to constrain the report
results to what the current user can see.
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Creating Custom Reports for OMDB

This section shows you how to create custom reports for the Opsware OMDB Client. The
recommended authoring environment for custom OMDB reports includes the following

items:

» A file transfer tool

« An SQL Query Tool

» Business Intelligence and Reporting Tools (BIRT) RCP Designer
(http://www.eclipse.org/birt) BIRT release 2_1_1

BIRT library file cmdb-data-sources.rptlibrary

JDBC driver file ojbcl4.jar

Turning OMDB Searches into Reports

The OMDB search engine makes it easy to generate rich SQL queries, and save them as
BIRT reports. In this example, we are using the OMDB search engine to look at the SAS
Server configuration items in the enterprise.

E Inthe OMDB Client, in the Search pane, expand Advanced Search, and then select
New Search.

H Select the SAS Server configuration item from the Search for Configuration Item
drop-down list.

E To find all servers with a reported OS value of either Linux or Windows, perform the
following steps:

1.

2 L A

Select the Reported OS criteria and Contains from the drop-down lists.
Enter Linux in the next field and click the plus (+) button.

Select or from the drop-down list.

Select Reported OS criteria from the drop-down list.

Select Contains criteria from the drop-down list.

Enter wind in the next field.
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Bl Click Search to generate the screen illustrated in Figure 4-1.

Figure 4-1: Search Screen
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These results are sorted by the first column Server Name.

B Click Result Options to specify a different sort priority.
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The screen illustrated in Figure 4-2 allows you to select Attributes to sort, and the
order in which each is considered.

Figure 4-2: Sort Order
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A From the Navigation pane, select Operating Systems from the list of Attribute Display
Name choices.

Select order number 1 from the Sorting Order drop-down list.

B Click OK.
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The sorted results of this modified search appear in Figure 4-3 below. Red Hat

comes before SuSE, which comes before VMware, which comes before the

Windows fam

ily.

Figure 4-3: Results Sorted by Operating System
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You can assign a name to the selection criteria used for this search, and save it as a
search. At a later date, you would be able to select the named search from the

OMDB client and run it again.

« (A= T 4:20Pm

However, you can also save this search as a BIRT report. Doing so will allow you to
open the report in BIRT to improve its appearance and functionality.

El Click Save Search.

E Save the search with a descriptive name, so that you can run it in the future from the

OMDB Client. Enter a Search Name, such as SAS_Server Search.
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EEl Select the Save as a Report Definition.

Figure 4-4: Save or Delete Your Search
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EE Click Save, and put the new SAS Server Search.rptdesign fileina
convenient directory on your local drive.

EE Start BIRT 2.1.1. In a Windows command prompt, run the command birt .exe.

KBl Open the SAS Server_ Search.rptdesign file that you just created.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 59



Opsware® OMDB 1.0.1 User’s Guide

As Figure 4-5 illustrates, the new report contains the form and content of the

information you selected when defining the report. The header information is already

in place.

Figure 4-5: New Report in BIRT
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EHE n the Outline pane, expand Data Sources, and then double-click the Data Source
icon.

E3 View the information for the new JDBC Data Source as shown in Figure 4-6.
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Click Test Connection to ensure that the report is connected.
Figure 4-6: JDBC Connection
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Create a new data source

<
Create a new data source
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Select the Preview tab, and review the report.

Figure 4-7: Preview Tab
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EE] Click on the XML Source tab to see the SQL query that the OMDB Client generated.

Figure 4-8: XML Source Tab

Ml BIRT RCP De

Fle Edt Insert Page Element Data Hun - Search window Help
(o ll@ e e s o o o
Palette | [8 DataExpl.. 2 [UbraryE., | © O

<property name="dataSource">cust-DataSource</propertys -
<property name="cueryText">SELECT distinct BASE TABLE.ITEM ID AS ITEM 1D,
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TABLE 2.COLUNN & AS COLUMN 8,
TABLE_1.COLUNN_2 45 COLUMN 2
FRON (SELECT BASE TABLE.ITEM ID &S ITEN ID,
BASE_TABLE. ITEN SOURCE_ID &S ITEN SOURCE_ID,
BASE_TABLE.CREATE DATE S CREATE DATE,
BASE_TABLE.NODIFY DATE kS MODIFY DATE,
BASE_TABLE.TND OF LIFE DATE A5 END OF LIFE DATE
FRON CNMDE_DATA.SAS_SERVERS_BASE BASE_TABLE) BASE_TABLE
LEFT OUTER JOIN (SELECT TABLE 1.ITEM ID &S ITEN ID,
TABLE_1.ITEN SOURCE_ID &S ITEN SOURCE_ID,
TABLE 1.BEGIN DATE A5 BEGIN DATE,

- =
Sfownez| =0 TABLE_1.END_DATE AS END_DATE,

TABLE_1.LATEST FLAG A5 LATEST FLAG, _'LI
3

4
Layout | Master Page | Script | <ML Saurce | Preview |

Property Editor - Data | = Properties EZI ~ =07

Prapert | value |
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E To group the output by operating system, select the top cell in the header row, right-
click and select Insert Group from the menu as shown in Figure 4-9.

Figure 4-9: Inserting a Group

N e B |

) I I I I

: Id Server Serial Primar Operati Man

E Name Numbe yIP n ctur
¥ g
- = System
< Undo Delete group ¥

: = [ITEM W Redo N [COLUMN | [COLUMN | [COLU
- 1] _1m 7

: B of Cutt

. B b MM SORY

? . Paste

- ¥ Delete

“_‘ Insert L4

5 LI IMerge Cells

) - Split Gell

Layout | Master Page | Script | sML So

Insert Group

Property Editor - Data =] Properties : e

Propert: Style ’

S "B — Edit Data Binding

ackgroun

The next window, illustrated in Figure 4-10, allows you to select the column that will
provide the group identity.
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EXl Select COLUMN_10 to specify the Reported OS column.

Figure 4-10: New Group Creation
=

‘ Group Details

Name: ~Sort Direction
| operatingsystem &+ hscending
P—— € Descending
Interval: Range: Before: [puto =
= =
[rio interval Ello = | after: o -

™| ise Fixed base value For intervals

I Hide Detail

IOC Item Expression:

¥ Repeat Headsr

~Filters and Sorting

Filters | Sorting |

Expression [ operator [ value 1 [ value 2 [

oK Caneel

EHA Click OK.

EEl Select the Layout tab.

EXA Select the Properties tab.
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H Select the Font properties to make this field smaller and darker.

Figure 4-11: Font Properties

_ini
Fle Edt Insert Page Element Data Run - Search Window Help
IG-El@-[a- |+ |- e

*+5AS Server Search.rptdesign £3 I ==

Palette | [8 DataExpl.. 52 [UbraryE., | T O

®-(f Data Sources
(5 Data Sets
(43 Report Parameters

== Header
- B Row
=00 cel

Evwent handler class

: ! E Data(col+
1| | »

: Id Server Serial Primary Operating Manufact Model Hos
5 Name Number IP System urer |
i {ICOLUMN 107 |
. [ITEM_ID] [COLUMN_0| [COLUMN_6] | [COLUMN_1] | [COLUMN_10] [COLUMN_7] | [COLUMN_8] | [COLT
& 1
B2 Outline 53 = .
[ cel N -
[ cen Kl | »
[ cel Layout | Master Page | Script | SML Saurce | Preview |
[ cell = =
O cel Property Editor - Data m g
[ cel Propert | value -
[ cel [=lData
[ cel [ Background
[2] Detail Bookmark
E Footer [Box
S 12 sroups | Comments |
i ] Custom XML
=] Table Group - Operating® Daka set
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As shown in Figure 4-12, the report now groups the output by operating system.

Figure 4-12: Preview of Grouped Report

M BIRT RCP Designer j =10l x|

Fle Edt Insert Page Element Data Run - Search Window Help

Ici-z [@- |- |4 ]| |[1om

Palette | [8 DataExpl.. 2 [UbraryE., | © O

Id Server Name

Red Hat
Enterprise
Linux AS
3

6056 core.ne 12 nedev. opsware. com

5989 falce. 0000, opsware. com

B2 Outline 53 =g

4

Serial Primary Operating Manufactureer

NumberIP System

VMWARE- 10.128.11.70 Fed Hat VMWARE, INC W

56 4D 06 86 Enterprise Linuz I

F28C1F AS3 PL.

4E-03 52 F1

672D 9D

C18F

220.15.157.24Red Hat DELL COMPUTER. PC

Enterprise Linug CORPORATION 650
L2 a

I v

Layaut | Master Page | Script | <ML Source | Preview

Property Editor - Data | ] Properties 53 I

Propert

| value |
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Inserting a Chart

BIRT can generate a chart to visually display selected elements of the output. Figure 4-13
displays the detailed SQL query that the SAS OMDB Client created. This is the search-
Result-Dataset based on the cust-DataSource data source.

Figure 4-13: SQL Query

pifi Edit Data Set - searchResult-DataSet

-Data Source

- Query

- Output Colurns

- Computed Columns
-Parameters

-Filkers

- Property Binding
-Cache Preference

- Preview Results

Query

=10l x|

Available Tkems:

=] B cust-DataSource
-8 CMDE_DATA

-0 TaMsvS

Schema: I-AII- j

Filter: |

Tvpe: I-AII- 'l EDD'YF"terl

™ Use identifier quoting

IFELECT distinct BASE TAELE.ITEM ID AS ITE ~

2 TABLE_1.COLUMN 0 AS COLUMN O,

3 TABLE_2.COLUMN & AS COLUMN &,

4 TABLE_1.COLUMN 1 AS COLUMN 1,

5 TABLE_3.COLUMN_10 AS COLUMN 10,

& TABLE_2.COLUMN_7 AS COLUMN 7,

7 TABLE_2.COLUMN 5 AS COLUMN &,

8 TABLE_1.COLUMN 2 AS COLUMN 2

9FROM (SELECT BASE_TABLE.ITEM ID AS ITEM I
10 BASE_TABLE.ITEM SOURCE ID AS ITEM SOU
11 BASE_TABLE.CREATE DATE AS CREATE DATE
12 BASE_TABLE.MODIFY DATE AS MODIFY DATE
13 BEASE_TABLE.END_OF_LIFE DATE AS END_OF

14FROM CMDE DATA.SAS SERVERS BASE BASE TAEBL
1SLEFT OUTER JOIN (SELECT TAELE 1.ITEM ID A

16 TAELE 1.ITEM SOURCE_ID AS ITEM SOURCE

17 TAELE 1.EBEEGIN DATE AS EEGIN DATE,

15 TAELE 1.END DATE AS END DATE,

19 TAELE 1.LATEST FLAG AS LATEST FLAG,

20 | TAELE 1.DfSPLJ\.Y NAME AS COLUMN O, =
4 3

o]

Cancel |

To create a new data set based on the same cust-DataSource data source, perform the

following steps.

E From the Data menu, select New Data Set.

Figure 4-14: New Data Set

i BIRT RCP Designer

File Edit Insert Page Element | Data ‘Window Help

It

[El-[F Data Sources

3 Truth

Data Sets

B Data Source

@ Report Parameters

Mew Data Source

e C|ass, rpdesic

Mormal | Master Pag
|

0
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H To learn how many instances of each operating system are currently online, in the
Query pane type the SQL statements Select Count (*) From and Group By. Then,
drag the desired Available Items from the middle pane to their places in the query
text.

The final SQL statement is:

select CMDB_DATA.SAS SERVERS.REPORTED OS,
count (*) from CMDB_DATA.SAS SERVERS
group by CMDB_DATA.SAS SERVERS.REPORTED_ OS

Figure 4-15: Data Set Query
MBEdtDataset Datasubset _loix]

Diata Source Query e - i

CQutput Columns

—————— Available Teems: lselect CMDE DATA.SAS SERVERS.REPORTED 05, -]
OMmnpUCes olumns - - — —
Parameters E1-E5] 5AS5_SERVERS | Zeount (%)
U | I B ITEM_ID (NUMEER) 3from CHDE_DATA.SAS SERVERS
oropertyBndng M B ITEM_SOURCE_ID (MUY 4group by CHDE_DATA.SAS SERVERS.REPORTED O:
Cache Preference | El BEGIN_DATE (TIMESTA
PreviewResute | i El END_DATE (TIMESTAMP

----- El LATEST_FLAG {(MUMEER:
----- B HOST_NAME (¥ARCHAR
----- E REPORTED_OS (¥ARCH.
----- El DISPLAY_MAME (VARCH

""" B MoTES (WARCHARZ) =
d : -

Schema: I-AII- j

Filter: |
Tvpe: I-AII- 'l EDD'YF"terl

-
™ Use identifier quoting 4| | _’I—I

Ok I Cancel |

H Click OK.

Bl Drag the Chart icon from the Palette tab to the Layout panel.
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From Select Chart Type menu, select Pie Chart.

Figure 4-16: Chart Type

New Chart

New Chart

Select chart bype and choose an output Format,

Pie Chart Title

AKX

Bar Chart
@ Ling Chart
u Area Chart
7
@ Meter Chart
! Scatter Chart
[ij_[ Stock Chart
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@ Click Next. A screen similar to Figure 4-17 appears.

Figure 4-17: New Chart

New Chart

New Chart

Select the data to display in the chart and bind it to the series,

Select Chart Type [Select Datal Format Chart

rSlice: Size Definition:

ISeries 1 'l!l
[rowf"eounTey fy| oo
L

Chart Preview

25—

Pie Chart Title

215;\ {50

=1

50

I RedHatE..

B Linux4AS
[] Sun0S54
[ AIX43

B Sun0S51

L Category Definition: | row["REPORTED_05"]

Select Data Set

" Inherit Data from Container

% |se Data Set

Data Preview

A |

—
Optional Grouping:

A

Group Sorking:

IAscending - l

i} |

IData SubZet VI Create New. .. |

the appropriate text field,

Filters. .. |
Parameters. ., |
-

REPORTED_OS |[Eami 1
Red Hat Enterprise Linux A5 3 50

Linux 445 1

SUn0S 5.9 25

ALX 4.3 25

SUROS 5.10 50

T =

i

_>|_I Data Binding. .. |

To bind a data column ko the chart, use the right-click menu or drag the column to

< Back

Mext = |

Einish | Cancel |

From the Select Data Set option, select Use Data Set, and then select Data SubSet
from the drop-down list. The Data Preview pane displays the contents of the data set.
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KXY Click Next.

Figure 4-18: Report Operating Systems

New Chart |
New Chart -
Fine tune your chart by defining the series properties, interactivity, layout, as well as general formatting of text, shadows, :
background and borders,
Select Chart Type | Select Data [Format Chartl
- Series Chart Preview
- Cakegory Series
-Value Series 2
o Reported Operating Systems
-Plat 1
..... Legend 50
25 7/\\ [ Red Hat Enterpris...
L) B Linux4as
— [] Sun0S54
| “—10
25—’ [] Al43
B 5un0s5.10
50 B WWindows NTE.2
Chart Area
Chart Title: |Rep0rted Operating Systems _I v visible
Background: I j
Skyle: INone j [V Enable in Preview
Inkerackivity
v Enable
Legend Behavior: INone j
Title Interactivity | Chart Area Inkeractivity |
Title Format | Qutline | General Properties | Custom Properties |
Help < Back | [dext = | Einish | Cancel

EEl Select the Chart Area line to call up the input fields. You can use these to assign a
chart title and to define the background.

EH Click Finish.
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As Figure 4-19 shows, the Layout view displays an icon of the chart, rather than the

chart itself.

Figure 4-19: Layout View

Ies-B @~ %- |+ |E-|
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&

Chapter 4: Creating Custom Reports

=10l x|
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Drag the chart icon to the top of the
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KB Pull the handles on the icon to expand it.

Figure 4-20: Chart Icon
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K Click Preview.

Figure 4-21: Report Preview
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Integrating a Custom Report into the OMDB Client

To integrate the report into the OMDB Client, perform the following steps:

Copy the custom report to the /opt/opsware/omdb/reports directory. Repeat
this step for additional cores as needed; report files aren't automatically replicated.

To see this report listed in the OMDB Client, add it to report_def .xml.

Modify the report_def.xml file in the /opt/opsware/omdb/deploy/birt.war
directory that the OMDB Client uses to recognize, display, and invoke the reports

stored on each core. If you are using WinSCP, you can double-click on the report

def .xml file name to open the document for editing.

Insert a description of your report in the top part of the .xm1 file. The easiest way to
do that is to copy an existing report definition, paste it in, then modify the report
name, display name, and description to match your new custom report.
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In the following sample text, the new report is defined in the bold text.

<reportings>
<reports>
<location>/etc/opt/opsware/occ/reports</location>
<report name="ServerByOSChart.rptdesign">
<display names>ServerByOSChart Title</display
name>
<description>ServerByOSChart Desc</description>
<parameters>
</parameters>
</report>
<report name="SAS Server Search.rptdesign">
<display name>SAS Server Search</display names>
<description>SAS Server Search</description>
<parameters>
</parameters>
</report>

B Inthe report def.xml file, modify the folder section to specify where the new
report will go. In the following example, we are telling the SAS Client to make the
sample report available in the Compliance Reports folder.

<folder name="compliance reports'"s>
<display name>complianceReportsFolderDesc</
display name>
<folder reportss
<report name>
ServerConfigurationPolicyComplianceChart.rptdesign</report
name>
<report_name>SAS Server_ Search.rptdesign</report name>

<report
name>ApplicationPolicyComplianceChart.rptdesign</report
name>
<report name>
ApplicationPolicyComplianceTableByCustomer.rptdesign</
report_name>
<report
name>ApplicationPolicyComplianceByFacility.rptdesign</
report_name>
</folder_ reportss
<subfolderss>
<subfolder name>sox</subfolder namex>
</subfolders>
<parents>reports</parent>
</folders>
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Be careful when you edit the report def .xml file. Make a backup copy of the file

before you edit it. A typographical error can prevent all reports, custom or otherwise, from

being displayed.

When you use the OMDB Client, you can view

Creating OMDB-Derived Reports

and run your new report.

To create an OMDB report, perform the following steps:

E Launch BIRT RCP Designer.

H In the Outline pane, right-click Libraries, and then select Use Library. The Open

window shown in Figure 4-22 displays.

Figure 4-22: Assigning a Library to the Report

een
Look jr: IE}cIark j €] _?

birt-rep-report-designer-2_0_0
cmdb-data-sources
opsw-common-reporting. rptlibrary

File name: Icmdb-data-sources.rptlibrary

Filez of type: I"_rptlibrary

2|
B v
j Open I
j Cancel /L

Browse to the directory where omdb-data-sources.rptlibrary can be found,

select it, and click Open.

After you assign the library, you do not need to create a new data source. This library

automatically points the user to the JDBC

Bl View the data connection in the Edit Data

Opsware Inc. Confidential Information: Not for Redi
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H To test the data connection, click Test Connection.
Figure 4-23: Edit Data Source

pifi Edit Data Source - Data Source

=10l x|

- Property Binding

Database URL: | jdbec:oracle:thin:@cmdb, opsware . com: 1521 :cmdb

User Mame: | cmdb_reporter
Password: | FTITITITIITITIT)
JMDI URL: | java:fomdbReporterDS
Manage Drivers... | Test Connection..,

Ok I Cancel

78

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 4: Creating Custom Reports

@ Create and name a new data set as shown in Figure 4-24 and Figure 4-25.
Figure 4-24: New Data Set

i BIRT RCP Designer

File Edit Insert Page Element | Data Run Search ‘Window Help

= I l
JrJv J@v J%v J Mew Data Source J -
Palette
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Figure 4-25: Name New Data Set

i New Data Set '

Ed
New Data Set

Create a new data set, !: 1

Data Set Mame: | CMDE _sample

Data Source:

Data Sek Type: ISQL Select Query

= Back I Mext = I Eimish

Cancel

Click Next.
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B Create the SQL query. Drag and drop the selected data rows into the SQL panel on
the right, remembering to add SQL commands, commas, and spaces, as needed.

Figure 4-26: Creating SQL Query
JRI=TE

ata Source Query - -
Query
Cutput Columns
Computed Calurns
Parameters
Filters
Property Binding
Cache Preference
Preview Results

lselect * ﬂ
2from CMDE_DATA.NAS_DEVICES

=-33 cMpe_DATA
DATE_DIMENSICN_BASE

HAS_BPPROVAL_STATUS

MAS_CFG_POLICY_DEYICES
hAS_CFG_POLICY_DVC_GR.
hAS_CONFIGURATION_POL
hAS_CONFIGURATION_RUL
NAS_CONFIG_POLICY_RULE

i NAS_DEVICES &
| D)

Schema: I-AII- h
Filter: I

Type: |—AII— 'I BDD\YF\Iterl

I Use identif -
Use identifier quating LI 5

El Click Preview Results to see if the SQL parses and runs.

Figure 4-27: Preview Results

b Edit Data Set - CMDB_sample D ol x|

-Data Source Preview Results - o -
- Query
- Dukput Columns ITEM IO |_ITEM_SoURCE 1o BEGIN_DATE | Ene paTe | LaTEST FLAG |~
Computed Columns G056 8056 Jan 8, 2007 00 AM  Feb 21, 2007 00 AM 0
- Parameters 087 5057 Row 25, 2008 2:00 AM | Feb 21, 2007 200 AM 0
Fiters 053 5058 Aug 29, 2006 200 AM Feb 21, 2007 200 AM D
059 5059 Ort 12, 2006 100 &M Jan 1, 4000 1Z:00 &M 1
EZ?:;‘;:;:;TEE 8086 8085 Feb 22, 2007 :00 AM | Feb 22, 2007 3:00PM 0
! 057 5057 Feh 22, 2007 200 M Feb 22, 2007 300PM 0
- Preview Results 8088 8088 Feb 22, 2007 9:00 AM | Feh 22, 2007 3:00PM 0
086 5056 Feh 22, 2007 300 PM | Feb 22, 2007 200PM 0
057 5057 Feh 22, 2007 300 PM  Feb 22, 2007 200PM 0
053 5058 Feh 22, 2007 3:00 PM  Feb 22, 2007 200PM 0
086 5056 Feh 23, 2007 200 M Jan 1, 4000 12:00 &M 1
057 5057 Feh 23, 2007 200 &M Jan 1, 4000 12:00 &M 1
053 5058 Feh 23, 2007 200 &M Jan 1, 4000 1Z:00 &M 1
086 5056 Feb 21, 2007 3:00 PM  Feb 21, 2007 200PM 0
057 5057 Feh 21, 2007 300 PM  Feb 21, 2007 200PM 0
053 5058 Feb 21, 2007 3:00 PM  Feb 21, 2007 200PM 0
086 5055 Feh 22, 2007 200 PM Feb 23, 2007 300 AM 0 p
057 5057 Feh 22, 2007 200 PM Feb 23, 2007 300 AM 0
053 5058 Feh 22, 2007 200 PM  Feb 23, 2007 300 AM 0
086 5056 Feb 21, 2007 200 PM  Feb 22, 2007 300 AM 0
057 5057 Feb 21, 2007 200 PM | Feb 22, 2007 300 AM 0
053 5058 Feh 21, 2007 200 PM  Feb 22, 2007 300 AM 0
086 5056 Feh 23, 2007 3:00 M Feb 23, 2007 200 AM 0 -
:!Inﬂ aneT Esk 72 2007 2000 AR Eak 32 2007 Go0nn AM 0 _>|_|

KK Drag the Table icon from the Palette to the middle row of the layout grid.
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EEl \When the Insert Table window appears, set the number of columns to three.

BB Drag the desired fields from the Outline tab on the left into position on the table.

Figure 4-28: BIRT RCP Designer
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E venpor Named Expressions
B MopeL Jar Files:
E DEVICE_TvPE
E GEOGRAPHICAL_LOZATION Name I Add...
B comMENTS E _'ﬂ
= 4 | L
4| B
EEl Select the Preview tab to preview your report.
Figure 4-29: Show Report Parameters
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PEIMARY TPHOSTNAME COMMENTS

check

10.10.10.10  invalid Invalid device update

check

10.128.11.70 corencl2 nedev opsware com Device added from Detect Networlk Devices task 611, Update

10.128.11.72  omdb.ne 12 nedev.opsware. comDevice added from Detect WNetwork Devices task 611,
10.128.11.71 nasnclZncdev.opsware.com Dewvice added from Detect MNetwork Devices task 611, Added
as mactive, since the device type 15 undetenmned.
Dewice activated on Thu Jan 11 17:46:24 EST 2007

10.128.11.70 corenclZ nedev.opsware.com Device added from Detect MNetwork Devices task 611, Update

10.128.11.72 omdb.ncl2 nedev. opsware.comDevice added from Detect Wetwork Devices task 611,
10.128.11.71 nasnclZncdev.opsware.com Device added fom Detect Metwork Devices task 611, Added
as inactive, since the dewice type i3 undetermined

Device activated on Thu Jan 11 17:46:24 EST 2007 El

Layout | Master Page | Script | EML Source |Prevlew
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KB Integrate the new report into the Opsware OMDB Client. The procedure is described
in “Integrating a Custom Report into the OMDB Client” on page 75.

Advanced Topics For OMDB Custom Reports

This section contains the following advanced topics for OMDB custom report creation:
+ Parameter Substitution

» Dates

+ Actionability

Parameter Substitution

For the OMDB, a com.opsware.reporting.util package was created to use with
BIRT. Reports are currently JDBC-based and include embedded SQL. In the data-set of
the BIRT Reports for the OMDB, set the beforeOpen script to:

importPackage (Packages.com.opsware.reporting.util)

request = reportContext.getHttpServletRequest () ;

queryText = SqlUtilities.processBeforeOpenEvent (queryText,
params, request) ;

This will retrieve the SQL query for the report and pass it to a parser to replace any
runtime variables. Runtime variables for the OMDB reporter are denoted in the SQL as
ansi style C comments and have a begin and end tag. The begin tag is /*PARAM'n"*/ and
the end tagis /*/PARAM'n"' */ where 'n' is greater than 0. In addition to the begin and
end tags, there is a operator position tag /*C* /.

For example, the query below for a report with runtime value:

select full date

from cmdb data.date dimension

where 1 =1

/*PARAM1*/and full date /*C*/ = trunc(sysdate)/*/PARAM1*/

When the report is run, one of the following events occur:

+ If the user selects Any Value for the parameter, then the string between the begin and
end tags is removed.

« |f a value is picked with an operator (in, equal, not equal) then the string between the
operator position tag and end tag is replaced with the appropriate operator/parameter
value string.
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« If the parameter value is text and case-insensitive (by default), then the left-side
expression between AND or OR and the operator position tag will be enclosed by an
UPPER function. The parameter value will also be upper-case.

Parameters in report def .xml for OMDB take a string of SQL for their lookup values.
This is different from the way reports are parameterized in SAS, with a resource type and
resource field.

Report parameter substitution is not supported in local previews. To test this feature, you
must deploy it to the OMDB server.

Dates

The OMDB reporting data source omdb-reporter-ds.xml used by the OMDB BIRT
engine is configured to set all session connections to the current user's time zone as
these connections are accessed by BIRT. This allows for the use of certain functionality
within Oracle to ensure that date processing occurs and is displayed relative to the user's
time zone.

The OMDB cMDB-DATA schema includes a DATE_DIMENSION view that is useful in
creating the date-based SQL typically used in OMDB's historical reporting. This view
contains a number of date-related columns for reporting including FULL_DATE _LOCAL
and FULL_DATE_UTC. All columns are relative to the user's local midnight boundary
(including FULL _DATE_LOCAL) except for FULL_DATE UTC. FULL DATE _UTC is a
calculated value based on the offset of the user's time zone from FULL_DATE_LOCAL.
The time component of FULL DATE LOCAL is always midnight (00:00:00), so for
someone in New York (EST), FULL_DATE_UTC will be 5 hours later than FULL_DATE _
LOCAL meaning its time component will be 05:00:00.

When doing parameter substitution of single dates or date ranges, these values will be
substituted in the current user's time zone and should always be compared to
FULL_DATE LOCAL. When using the resulting DATE_DIMENSION records to access
historical data tables, the FULL DATE_UTC column must be used as all OMDB data time
stamps are UTC.

The following two functions are available for performing time zone offsets:
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+ UTC_TO_LOCAL: Use this to convert almost all OMDB time stamp columns to local

time for display in the user's local time zone

+ LOCAL_TO_UTC: This will convert a local time stamp to UTC, which may not be useful

for return to BIRT, but may be useful in other scenarios.

Almost all time stamp columns returned for display in BIRT should be wrapped in the
UTC_TO_LOCAL function for correct display. The only time you wouldn't do this is if there
is a need to display the date in UTC or if a BIRT expression is being used to convert the
UTC time stamp to some other desired value.

Actionability

OMDB reports can also support actionable items.

To set a table as actionable, perform the following steps:

=

Launch BIRT RCP Designer.

In the Outline pane, expand the report name, and then expand Body.
Select the table name.

In the Property Editor -table name, click the Properties tab.

In the Properties list, select Bookmark.

In the text field, enter the following string:

id="'"'actionable'!

From the File menu, select Save.

The format for OMDB actionable items is

source:object type:id

To add the source and object type to your custom report, perform the following steps:

Launch BIRT RCP Designer.

Expand Data Set.

Double-click the data set that is associated with the report.
In the query text field, add the following string:

'source:object type:' || objectid
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The actionable source and object type pairs are limited to:

sas:device:
sas:patch policy:
sas:configuration:
sas:compliance test:
sas:configuration:
sas:compliance test:
sas:job:

sas:user:
sas:usergroup:
sas:audit policy:
sas:audit_task:
sas:audit_ result:

Set the objectid to the object id in SAS or NAS. Do not set objectid to anitem
id in OMDB.

H nthe left list of the Edit Data Set window, click Output Columns.
@ Click OK.
Expand the Data Set.

B Drag the new column into the table as the first column of the Detail Row of the table.
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